
IMPRINT 1

1

iPlus Version 2.0

Answer Key4
Class
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	Computers—Storage and Memory Device

Let’s Catch Up   (Page no. 10)

a. 	� Primary memory is the main memory of a computer. CPU can directly access this memory. It is 
fixed on the motherboard of a computer.

b. 	� Memory Card is commonly known as multimedia memory card. It is very small in size usually 
1–1.5 inches. These are used in mobile phones and digital cameras.

Exercise
Section A (Objective)

A.	 1. 	 c	 2. 	b	 3. 	c	 4. 	a
B.	 1.	 USB	 2.	 Byte	 3.	 Optical Disc	 4.	 Zettabyte
C.	 1.	 T	 2.	 F	 3.	 T

Section B (Subjective)
A.	 1. 	� Secondary memory is permanent in nature and is not directly accessed by the CPU. It allows 

users to store data that may be easily retrieved. It is cheaper as compared to primary memory.
	 2. 	� A device, covered with a magnetic coating is called a magnetic disk. You can record and 

erase data on a magnetic disk any number of times.
	 3. 	� A CD-ROM is a CD containing data that has been written at the time of manufacturing. The 

data cannot be modified or erased.
B.	 1. 	 RAM ROM

a. �RAM is a temporary memory. The 
information stored in this memory is lost 
when the computer is turned off. 

a. �Information stored in ROM is permanent 
in nature, i.e., it holds the data even if the 
system is switched off. 

b. �It temporarily stores data and instructions 
given by the user and also the results 
produced by the computer.

b. �It holds the starting instructions that are 
required to start a computer. 

c. It is also called volatile memory. c. It is also called non-volatile memory. 

1.



2

IMPRINT 1

iPlus (Ver. 2.0)-IV (Answer Key)

	 2.	� The hard disk consists of one or more magnetic disks. Each disk in the pack has top and 
bottom surfaces on which data is recorded using magnetic head. The most important function 
of the hard disk is to store program files and data files.

	 3. 	� (This question was printed incorrectly in the book. Please correct it in your textbook.)
		  Question. �Define memory in respect of a computer. Name some of the units used for 

measuring the computer's memory.
		  Ans. �The storage space in a computer is called memory. The data and instructions that 

are entered into the computer using input devices are stored inside the memory. 
Byte, kilobyte, megabyte gigabyte, etc., are some of the units used for measuring the 
computer's memory

C.	 1. 	� I can add a memory card to increase my smartphone’s storage space so that I can store more 
photos and videos.

	 2. 	 c

Crack The Code
a. 1		 b. 4		  c. 3	 d. 2

	GUI Operating System—Desktop Management

Let’s Catch Up   (Page no. 21)

a.	 TASK BAR	 b.	 DESKTOP	 c.	 BACKGROUND	 d.	 ICONS

Exercise
Section A (Objective)

A.	 1.	 b		  2.	 b	 3.	 d	 4.	 b
B.	 1.	 (This question was printed incorrectly in the book. Please correct it in your textbook.)
		  Question. .................. was released on 5th October, 2021.
		  Ans. Windows 11	
	 2.	 (This question was printed incorrectly in the book. Please correct it in your textbook.)
		  Question. �The ................... in Windows 10 is the main interface between the user and the 

computer.
		  Ans. desktop
	 3.	 left, right
C.	 1.	 T	 2.	 F	 3.	 T	 4.	 F
D.	 1.	 This PC	 2.	 Folder	 3.	 Start button	 4.	 Recycle Bin

2.
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Section B (Subjective)
A.	 1. 	 The names of any two components of the Windows 10 desktop are background and icons.
	 2.	� “This PC” allows you to view all of the data on your computer. It is useful for sorting, finding, 

and storing files on your computer.
	 3.	� The quick launch bar is located on the taskbar. It contains the shortcut to open various programs.
	 4.	 Icons are small images or symbols with names that represent programs, folders or files.
B.	 1.	� Taskbar is a long horizontal bar located at the bottom of the desktop. It helps to manage 

various currently active programs, opened in different windows.
		  To change the position of the taskbar, follow the given steps:
		  Step 1:  	Right-click on the taskbar and uncheck the Lock the taskbar option by clicking on it.
		  Step 2: 	Now, point to the taskbar and drag it to any side of the screen.
	 2.	 To change window’s colour scheme, follow the given steps:
		  Step 1: 	Right-click on the desktop and choose Personalize option.
		  Step 2: 	Click on Colors.
		  Step 3: 	Click on Choose your color arrow and select any option you want to use.
		  Step 4: 	Click on the Transparency effects option.
		  Step 5: 	Tick under the Choose your accent color option.
	 3. 	� On the right side of the taskbar, the current date and time are displayed on the clock. 
		�  Even if the computer is switched off, your computer keeps the date and time updated 

automatically with the help of a small battery inside it. 
		  The steps to change the date and time are:
		  Step 1: 	Right-click on Clock.
		  Step 2: 	Click on Adjust date/ time option. 
		  Step 3: 	Click on the Change button. 
		  Step 4: 	�Click on the down arrow to select the month, date, and year as needed to select the 

correct date. 
		  Step 5: 	Click on down arrow button to select time as needed to select the correct time. 
		  Step 6: 	Click on the Change button.

Crack The Code
	 1.	 Windows Color	 2. Wallpaper	 3. Taskbar	 4. Start button

	Editing in Word 2016

Let’s Catch Up   (Page no. 28)

The Backspace key is used to delete text from the left side of the cursor.
The Delete key is used to delete text from the right side of the cursor.

3.
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	Formatting in Word 2016

Let’s Catch Up   (Page no. 44)

a. 	 Paragraph	 b. 	Font	 c. 	Paragraph	 d. 	Font

Exercise
Section A (Objective)

A.	 1.	 b	 2.	 b	 3.	 b	 4.	 c
B.	 1.	 right	 2.	 Line spacing	3.	 bullet	 4.	 Enter

C.	 1. i. Text Effect

2. ii. Underline

3. iii. Left Align

4. iv. Justify

5. v. Italic

Section B (Subjective)
A.	 1.	 Font is the look of the alphabet on the screen. Two fonts are:
		  a. 	 Arial
		  b. 	 Calibri
	 2. 	� The position of the text or the way the text is set with respect to the margins in a document 

is called alignment.
	 3. 	 Italic means slanted text.
B.	 1.	 The steps to change line spacing are:
		  Step 1: Click on the Home tab.
		  Step 2: Place the cursor without selecting the text.
		  Step 3: Click on Line and Paragraph Spacing tool.
		  Step 4: Choose the line spacing you want.
	 2. 	� Paragraph Spacing is the blank space between two paragraphs, both before and after the 

paragraph. Click on the Paragraph pull-down arrow in the Paragraph group under the Home 
tab. Choose any style of spacing from the Paragraph Spacing drop-down menu.

4.Exercise
Section A (Objective)

A.	 1.	 a	 2.	 c	 3.	 b	 4.	 c
B.	 1.		 select, Backspace	 2.	 blue	 3.	 Undo	 4.	 Spell check	
	 5.	 Thesaurus
C.	 1.	 F	 2.	 T	 3.	 T
D.	 1. 	 Shift + Right Arrow	 2. 	Shift + Up Arrow		 3. 	Ctrl + Shift + Right Arrow
	 4. 	 Ctrl + Shift + Left Arrow	 5. 	Ctrl + A

Section B (Subjective)
A.	 1.	 Two features of Word 2016 are:
		  a. 	 type letters, stories, reports, etc., in a simple way. 
		  b. 	 copy and move the text wherever required.
	 2.	� Thesaurus is a collection of words with their synonyms. In Word, Thesaurus tool gives us a 

list of synonyms for a selected word. 
	 3.	 Backspace or Delete key can be used to correct our mistakes.
B.	 1. 	 Undo Redo

a. �Undo is used to cancel the last/
previous command.

a. �Redo is used to reverse the action of 
the last Undo command.

b. Shortcut keys to Undo are Ctrl + Z. b. Shortcut keys to Redo are Ctrl + Y.

	 2. 	 a. 	� Deleting the text means that if  you have made a mistake while typing the text, you can 
easily remove the text by using either the Backspace or Delete key.

		  b. 	� Cutting the text means that the selected text will disappear from its original location and 
will appear at another location where it is pasted.

	 3. 	 The steps to create a new document are:
		  Step 1: 	Click on the File tab.
		  Step 2: 	Select the New option.
		  Step 3: 	Click on the Blank document option.
C.	 Saransh can use Ctrl + Z keys to undo the text.

Crack The Code
Step 1: Select the text.
Step 2: Click on Home tab.
Step 3: Click on Copy from the Clipboard group.
Step 4: �Move the cursor to the place where you want to paste your text and click on Paste from 

Clipboard group.
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	Formatting in Word 2016

Let’s Catch Up   (Page no. 44)

a. 	 Paragraph	 b. 	Font	 c. 	Paragraph	 d. 	Font

Exercise
Section A (Objective)

A.	 1.	 b	 2.	 b	 3.	 b	 4.	 c
B.	 1.	 right	 2.	 Line spacing	3.	 bullet	 4.	 Enter

C.	 1. i. Text Effect

2. ii. Underline

3. iii. Left Align

4. iv. Justify

5. v. Italic

Section B (Subjective)
A.	 1.	 Font is the look of the alphabet on the screen. Two fonts are:
		  a. 	 Arial
		  b. 	 Calibri
	 2. 	� The position of the text or the way the text is set with respect to the margins in a document 

is called alignment.
	 3. 	 Italic means slanted text.
B.	 1.	 The steps to change line spacing are:
		  Step 1: Click on the Home tab.
		  Step 2: Place the cursor without selecting the text.
		  Step 3: Click on Line and Paragraph Spacing tool.
		  Step 4: Choose the line spacing you want.
	 2. 	� Paragraph Spacing is the blank space between two paragraphs, both before and after the 

paragraph. Click on the Paragraph pull-down arrow in the Paragraph group under the Home 
tab. Choose any style of spacing from the Paragraph Spacing drop-down menu.

4.
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	 2. 	 (This question was printed incorrectly in the book. Please correct it in your textbook.)
		  Question. �The ................ in Windows 10 is the main interface between the user and the 

computer.
		  Ans. desktop
	 3. 	 Enter
C.	 1.	 T	 2.	 F	 3.	 T

Section B

A.	 1.	� A device, covered with a magnetic coating is called a magnetic disk. You can record and 
erase data on a magnetic disk any number of times.

	 2.	 The names of any two components of the Windows 10 desktop are background and icons.
	 3.	� When we copy a text, the selected text will remain at its original location as well as the place 

where it is pasted.
B.	 1.	� The hard disk consists of one or more magnetic disks. Each disk in the pack has top and 

bottom surfaces on which data is recorded using magnetic head. The most important function 
of the hard disk is to store program files and data files.

	 2. 	 Editing Formatting
�Editing is used to make changes in 
documents by using editing tools such 
as- Copy/Cut and paste, and Select and 
Delete text.

Formatting is used to improve the 
appearance of text in a document by 
using formatting tools such as- Change 
font name and size, and make the text 
bold, italic, and underlined.

	 3. 	 To change window’s colour scheme, follow the given steps:
		  Step 1: Right-click on the desktop and choose Personalize option.
		  Step 2: Click on Colors.
		  Step 3: Click on Choose your color arrow and select any option you want to use.
		  Step 4: Click on the Transparency effects option.
		  Step 5: Tick under the Choose your accent color option.

	The Internet—Web Browser

Let’s Catch Up    (Page no. 54)

a.	 URL
b.	 Internet Service Provider
c.	 Hyperlink

5.

	 3. 	 The steps to apply bullets are:
		  Step 1: Select the text.
		  Step 2: Click on Home tab.
		  Step 3: Choose the Bullets option.
	 4. 	 Editing Formatting

�Editing is used to make changes in 
documents by using editing tools such 
as- Copy/Cut and paste, and Select and 
Delete text.

Formatting is used to improve the 
appearance of text in a document by 
using formatting tools such as- Change 
font name and size, and make the text 
bold, italic, and underlined.

C.	 Akanksha can use bullets or numbering to write her words in a list in her document.

Crack The Code
	 1.	 Shortcut Keys			   2. 	Text effects			   3.	 Font color
	 4. 	 Formatting			   5. 	Bullet

Worksheet 1  (Based on chapters 1 to 4)

(Page no. 48)

A.	 1.	 This PC	 2.	 Folder	 3.	 Recycle Bin	 4.	 RAM
	 5.	 DVD	 6.	 Memory Card
B.	 Start button

Quick launch bar Clock

C.	 1.	 Wallpaper			   2. 	Print Preview			   3. 	Line Spacing	
	 4. 	 Undo			   5. 	Formatting
C.	 1. 	 Ctrl + S	 2. 	Ctrl + O	 3. 	Ctrl + Z	 4. 	Ctrl + Y	 5. 	Ctrl + B

(Based on chapters 1 to 4)
Test Sheet 1

Section A

A.	 1.	 c 	 2.	 d	 3.	 c
B.	 1. 	 Byte	
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	 2. 	 (This question was printed incorrectly in the book. Please correct it in your textbook.)
		  Question. �The ................ in Windows 10 is the main interface between the user and the 

computer.
		  Ans. desktop
	 3. 	 Enter
C.	 1.	 T	 2.	 F	 3.	 T

Section B

A.	 1.	� A device, covered with a magnetic coating is called a magnetic disk. You can record and 
erase data on a magnetic disk any number of times.

	 2.	 The names of any two components of the Windows 10 desktop are background and icons.
	 3.	� When we copy a text, the selected text will remain at its original location as well as the place 

where it is pasted.
B.	 1.	� The hard disk consists of one or more magnetic disks. Each disk in the pack has top and 

bottom surfaces on which data is recorded using magnetic head. The most important function 
of the hard disk is to store program files and data files.

	 2. 	 Editing Formatting
�Editing is used to make changes in 
documents by using editing tools such 
as- Copy/Cut and paste, and Select and 
Delete text.

Formatting is used to improve the 
appearance of text in a document by 
using formatting tools such as- Change 
font name and size, and make the text 
bold, italic, and underlined.

	 3. 	 To change window’s colour scheme, follow the given steps:
		  Step 1: Right-click on the desktop and choose Personalize option.
		  Step 2: Click on Colors.
		  Step 3: Click on Choose your color arrow and select any option you want to use.
		  Step 4: Click on the Transparency effects option.
		  Step 5: Tick under the Choose your accent color option.

	The Internet—Web Browser

Let’s Catch Up    (Page no. 54)

a.	 URL
b.	 Internet Service Provider
c.	 Hyperlink

5.
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Exercise
Section A (Objective)

A.	 1.	 c	 2.	 c	 3.	 a
B.	 1.	 WWW	 2.	 Web pages	 3.	 Home page	 4.	 Internet
C.	 1.	 T	 2.	 T	 3.	 F	 4.	 T

Section B (Subjective)
A.	 1. 	� A web browser is a software program that helps the user in opening and displaying the 

different web pages. The different types of web browsers are Google Chrome, Microsoft 
Edge, Mozilla Firefox, etc.

	 2.	� ISP stands for Internet Service Provider. It is a company that provides Internet access on 
payment of a monthly fee. Some of the ISPs are MTNL (Mahanagar Telephone Nigam Limited.), 
BSNL (Bharat Sanchar Nigam Limited), Jio, Airtel, Vodafone, etc.

	 3. 	 Online Offline
When the user works on a system with 
an Internet connection then it is called 
online. 

When the user works on a system 
without an Internet connection then it 
is called offline.

B.	 1. 	� The Internet is a network in which millions of computers are connected to one another to 
share information. It is also called International Network.

		  Three uses of the Internet are:
		  a.	 search for information on any topic
		  b.	 share information with others
		  c.	 send and receive e-mail messages
	 2. 	 The main parts of Microsoft Edge window are:
		  a. 	� Current Tab: Edge uses tabs for each web page you have open. The current tab you have 

open appears as a light grey, while those not open are dark grey. 
		  b. 	� Back/Forward: The back button helps you to navigate back to your previous page and 

forward button allows you to move forward again, if necessary. 
		  c. 	 New Tab: Click this button to open a new tab. 
		  d. 	 Refresh: Refresh button reloads your page.
	 3. 	 The steps to use a search engine are:
		  Step 1: Open a search engine and type www.google.com.
		  Step 2: Type the desired keyword in the search box.
		  Step 3: Press Enter key or click the Search icon.
		  Step 4: Click on the link you find most relevant and read the information.
C.	 Step 3: Open a web browser.
	 Step 5: Complete the essay using the information from the Internet.
	 Step 1: Start the computer. 
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	 Step 2: Connect the computer to the Internet. 
	 Step 4: Search for the topic “The History of Computers”. 

Crack The Code
1.	 MODEM      2.  TELEPHONE LINE      3. 	 COMPUTER SYSTEM    4.  WEB BROWSER

	Introduction to PowerPoint 2016

Let’s Catch Up    (Page no. 65)

a. SLIDE 	 b. PRESENTATION 	 c. BACKSTAGE	 d. PLACEHOLDER 		  e. POWERPOINT 

Exercise
Section A (Objective)

A.	 1.	 c	 2.	 b	 3.	 b
B.	 1.	 Ribbon	 2.	 slide	 3.	 PowerPoint	 4.	 Slide show
C.	 1.	 F	 2.	 T	 3.	 F	 4.	 F	 5.	 F

D.	 1. a.    Reading View

2. b.   Normal View

3. c.  Slide Sorter View

4. d.  Outline View

	

	

Section B (Subjective)
A.	 1. 	� PowerPoint is a part of the Microsoft Office package. It is a program that allows you to create 

presentations. You can also animate objects and add videos or music to your presentations 
to make them more attractive.

	 2. 	 A placeholder is a dotted box on a slide that may contain text, a picture, a video, etc.
	 3. 	 The name of any three components of the PowerPoint screen are Title bar, Ribbon and Slide.

6.
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B.	 1. 	 The steps to save a presentation are:
		  Step 1: Click on the File tab.
		  Step 2: Click on the Save or Save As button.
		  Step 3: Click on Browse and select the desired location.
		  Step 4: Click on the File name text box and type a name for the file.
		  Step 5: Click on the Save button.

	 2. 	 The steps to create a new presentation are:
		  Step 1: Click on File tab.
		  Step 2: Select New option.
		  Step 3: Click on Blank Presentation.
	 3.	� The slide layout is the arrangement of text, images, ClipArts, charts, etc., on a particular slide. 

PowerPoint provides you with a variety of slide layouts that you can choose from as per your 
requirements. There are nine in-built slide layouts available in PowerPoint.

	 4. 	 Slide Sorter View Reading View
Slide Sorter View allows us to view all 
slides of a presentation as thumbnails on 
a single screen.

Reading View allows us to view a presentation 
not in full screen but in a window with simple 
controls that make the presentation easy to 
review. The ribbon and the slides/ outline 
pane are not visible. 

Crack The Code
Quick Access Toolbar Title Bar

Ribbon

Slides/Outline 
Pane

Placeholder

Status Bar

Slide



IMPRINT 1

11iPlus (Ver. 2.0)-IV (Answer Key)

	Stepwise Thinking

Let’s Catch Up    (Page no. 74)

3
2
1
4

Exercise
Section A (Objective)

A.	 1.	 a	 2.	 b	 3.	 a	 4.	 a
B.	 1.	 F	 2.	 F	 3.	 F	 4.	 T
C.	

	 4 	 3

	

	 2 	 1

Section B (Subjective)
A.	 1. 	 The process of completing one step and going on to the next is known as Stepwise Thinking.
	 2. 	 Computational thinking means ‘thinking like a computer’.
	 3. 	 A case study refers to a task that is based on real-life situations.
B.	 1. 	 Reasoning Problem solving

Reasoning is the process of thinking 
about the task in a logical or sensible 
way. It helps you to choose the correct 
option in the available options.

Problem solving is the process of finding 
solutions to a difficult task. 

7.



12

IMPRINT 1

iPlus (Ver. 2.0)-IV (Answer Key)

	 2. 	 The steps to organise a birthday party by using stepwise thinking are:
		  Step 1: 	Make a list of family members and friends to be invited.
		  Step 2: 	Decide the date, time and place for the party.
		  Step 3:	� Inform family members and friends about the party place through phone calls or e-mail.
		  Step 4:	 Make necessary arrangements like setting, eating and entertainment.
		  Step 5:	 Greet the guests with love and warmth.
		  Step 6:	 Start and enjoy the party.
		  Step 7:	 Farewell to the guests.
	 3. 	 The steps to plan to play board games with your friends at home are:
		  Step 1:		 Decide time with your friends.
		  Step 2:	 Decide the place in your home where you all will play.
		  Step 3:	 Ask your mother for drinks and snacks that you can offer your friends.
		  Step 4:	 Welcome your friends to your home. Offer them drinks.
		  Step 5:	 Start playing the game.
		  Step 6:	 Enjoy snacks with your friends after the game.
		  Step 7:	 Bid farewell to friends.

C.	 1. 	 The steps to prepare maggi are:
		  Step 1: 	Put pan on the stove. 
		  Step 2:	 Add water in the pan. 
		  Step 3:	 Add Maggi and maggi masala in the boiling water. 
		  Step 4:	 After 2 minutes serve it.
	 2. 	 The steps to take care of Kartik are:
		  Step 1:	 Wash the injury.
		  Step 2:	 Apply first aid.
		  Step 3:	 Take him to the doctor

Crack The Code

1
2
3
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	Features of File Management

Let’s Catch Up    (Page no. 81)

a. 	 Excel file
b. 	 PowerPoint file
c. 	 Music file
d. 	 Video file

Exercise
Section A (Objective)

A.	 1.	 b	 2.	 a	 3.	 c	 4.	 b	 5.	 a
B.	 1.	 downloads	 2.	 selected	 3.	 subfolder	 4.	 picture	
C.	 1.	 T	 2.	 F	 3.	 F	 4.	 T	

Section B (Subjective)
A.	 1. 	 Downloads folder is used to store the files that are downloaded from the Internet.
	 2. 	� Opening other’s files and making any changes to them without informing the file owner is 

called tampering.
	 3. 	� The file/folder that is deleted goes to the Recycle Bin and remains there until and unless they 

are not removed from there.
B.	 1. 	 The steps involved in restoring a deleted file/folder are:
		  Step 1: 	Open Recycle Bin.
		  Step 2:	 Select the file.
		  Step 3:	 Click on the Restore the selected items option.
	 2. 	 (This question was printed incorrectly in the book. Please correct it in your textbook.)
		  Question. Write the steps to create a new file/folder.
		  Ans. The steps to create a new file/folder are: 
		  Step 1: Open the folder in which you want to create the file.  
		  Step 2: Right-click in an empty section and click on the New option.  
		  Step 3: Click on the type of file you want to create from the list. 
		  Step 4: Type the name for the new folder or file and press the Enter key. 
	 3. 	� A file is a collection of data and information, stored on a storage device such as hard disk, 

pen drive, CD/DVD. 
		  The steps to move a file are:
		  Step 1:	 Open the folder containing the file you want to move.
		  Step 2:	 Select the file.

8.
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		  Step 3:	 Click on the Home tab.
		  Step 4:	 Click on the Cut command.
		  Step 5:	 Open the new location where you want to paste your file.
		  Step 6:	 Click on the Home tab.
		  Step 7:	 Click on the Paste command.

Crack The Code
1. 	 Ctrl + C	 2. 	Ctrl + X	 3. 	Ctrl + V	 4. 	F2	 5. 	Ctrl + Shift + N

Worksheet 2  (Based on chapters 5 to 8)

(Page no. 90)

A.	 1. Modem a.	

2. Cables b.	

3. ISP c.	

4. Web browser d.	

B.	 1. 	� Title Bar: The title bar is located at the top of the PowerPoint window. It shows the name of 
the current presentation or the name by which the presentation is saved.

	 2. 	� Control Buttons: On the right of the Title bar, there are three buttons - Minimize button, 
Maximize/Restore Down button, and Close button.

	 3. 	 Ribbon: The ribbon contains multiple tabs, each with several groups of commands.
	 4. 	 Slide: A slide is a page in a presentation. 
	 5. 	� Speaker’s Notes Pane: The speaker’s notes pane is where the speaker can write notes for 

himself. These notes can only be viewed by the speaker. 
C.	 1. 	 Problem solving is the process of finding solutions to a difficult task.
	 2. 	 A folder is like a file cabinet in which you can keep your files.
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(Based on chapters 5 to 8)
Test Sheet 2

Section A

A.	 1.	 a 	 2.	 c	 3.	 a
B.	 1. 	 Web pages	 2. 	PowerPoint	 3. 	selected
C.	 1.	 F	 2.	 F	 3.	 F

Section B

A.	 1. 	� Web browser is a software program that helps the user in opening and displaying the different 
web pages. The different types of web browsers are Google Chrome, Microsoft Edge, Mozilla 
Firefox, etc.

	 2. 	 The name of any three components of the PowerPoint screen are Title bar, Ribbon and Slide.
	 3.  	Computational thinking means ‘thinking like a computer’.
B.	 1. 	� The main parts of Microsoft Edge window are:
		  a. 	� Current Tab: Edge uses tabs for each web page you have open. The current tab you have 

open appears as a light grey, while those not open are dark grey. 
		  b. 	� Back/Forward: The back button helps you to navigate back to your previous page and 

forward button allows you to move forward again, if necessary. 
		  c. 	 New Tab: Click this button to open a new tab. 
		  d. 	 Refresh: Refresh button reloads your page.
	 2. 	� The slide layout is the arrangement of text, images, ClipArts, charts, etc., on a particular slide. 

PowerPoint provides you with a variety of slide layouts that you can choose from as per your 
requirements. There are nine in-built slide layouts available in PowerPoint.

	 3. 	 The steps involved in restoring a deleted file/folder are:
		  Step 1:	 Open Recycle Bin.
		  Step 2:	 Select the file.
		  Step 3:	 Click on the Restore the selected items option.


